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Der Empfänger wurde in [1] vorgestellt,
die Preselektor-Baugruppe war Gegen-
stand eines Beitrags in [2]. Auf den Inter-
netseiten des FiFi-SDR-Projekts [3] fin-
den sich dazu weitere Informationen und
entsprechende Links. Die Betreiber und

Entwickler freuen sich über sachdienliche
Hinweise, Vorschläge und Erfahrungsbe-
richte und sind auch gern bereit, Fragen zu
beantworten. 
Im Rahmen der Weiterentwicklung und
Verbesserung des Bausatzes wurden im
Laufe der Zeit einige Schaltungsdetails
optimiert. Der Empfänger in der Version
2.0 besitzt einen neuen Soundchip. Aller-
dings lässt sich die damit mögliche höhere
Samplingrate noch nicht mit jeder SDR-
Software ausnutzen.
Der FiFi-SDR ist vom HF-Konzept her ein
Direktmischempfänger und Einsteigerpro-
jekt. Die technologische Ausführung mit
ARM-Prozessor und programmierbarem
Logikbaustein in relativ dicht gepackter
SMD-Bestückung ist allerdings sehr an-
spruchsvoll. Aus diesem Grund wird der
Bausatz weitestgehend vorgefertigt ausge-
liefert. Der Empfänger ist mit einem
Soundchip ausgestattet, der eine Abtastra-
te bis zu 192 kHz ermöglicht. Darüber hin-
aus verfügt er über einen VFO, der einen
durchgehenden Empfangsbereich von MW
bis KW zulässt (siehe Tabelle 1). 

Der Mini-Empfänger ist auf gute Emp-
findlichkeit für den Einsatz an kurzen An-
tennen optimiert. Starke Signale können
ihn deshalb übersteuern und den Empfang
deutlich verschlechtern oder gar unmög-
lich machen. Ein Dämpfungsglied zwi-

schen Antenne und Empfängereingang
kann da Wunder bewirken. Hier sind der
Initiative und der Kreativität des Nutzers
kaum Grenzen gesetzt.
Zum Betrieb des FiFi-SDR ist grundsätz-
lich jede Softrock40-kompatible PC-Soft-
ware geeignet. Sie muss I/Q-Signale ver-

arbeiten und sollte den Si570-VFO steuern
können. 
Die Programminstallation und die Bedie-
nung des Empfängers mithilfe der Soft-
ware setzen Grundkenntnisse und -fertig-
keiten im Umgang mit PC und Betriebs-
system voraus.
Der Bausatz enthält zwei vorbestückte
Platinen, alle bedrahteten Bauteile und ein
bearbeitetes Gehäuse. Auf der beiliegen-
den CD befinden sich die Baumappe und
die für einen erfolgreichen Start benötigte
Software. Die Treiberdatei für den USB-
Anschluss des FiFi-SDR-Empfängers ist
nicht nur für Windows XP, sondern auch
für Windows 7 geeignet. 
Viele der derzeit verbreiteten SDR-Pro-
gramme sind nicht unter Windows 7 ein-
setzbar. Oft scheitert schon die Installa-
tion. Mit zunehmender Nachfrage werden
auch hier sicher Lösungen angeboten. Es
lohnt sich, von Zeit zu Zeit das Internet zu
durchforsten und nach entsprechend ange-
passten und weiterent wickelten SDR-Pro-
grammen Ausschau zu halten. Unter Win-
dows 8 wurde von uns bisher noch keine
SDR-Software getestet. 
Um den Einstieg zu erleichtern, befindet
sich auf der beigelegten CD ein SDR-Pro-
gramm, das für erste Experimente gut ge-
eignet ist. Rocky 3.6 ist sowohl unter Win-
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liegenden Bausatzversion ist er mit einer integrierten Soundkarte und 
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Bild 2: Schaltungskonzept des FiFi-SDR

Tabelle 1: Technische Daten

Empfangsbereich: 200 kHz bis 30 MHz
Betriebsspannung: 5 V via USB
Empfangskonzept: Direktmischung
Vorselektion: Preselektorbaugruppe 
Eingangsempfindlichkeit (7…21 MHz)
SSB: –106 dBm / 1,12 µV @ 10 dB SINAD
IP3: –10 dBm @ 21 MHz/21,050 MHz 
Abmessungen (B ¥ H ¥ T): 
55 mm ¥ 24 mm ¥ 110 mm
PC-Anforderungen: Windows ab XP, Mac-OS, 
Linux, 1 GHz, ≥ 256 KByte RAM (je nach 
Betriebssystem)
Onboard-Soundkarte: 
Samplingrate max. 192 kHz
nutzbare Software: siehe Tabelle 3

Bild 1: 
Vollständig aufge-
bauter FiFi-SDR-
Empfänger



dows XP als auch unter Windows 7 lauf-
fähig und einfach zu bedienen.
Ein USB-Verbindungskabel liegt dem Bau-
satz nicht bei. Es ist im Fachhandel erhält-
lich.

� Kurzbeschreibung 
der Schaltung

Das an der Antennenbuchse eingespeiste
HF-Signal durchläuft zunächst einen Vor-
verstärker mit nachgeschaltetem Preselek-
tor. Diesem folgen eine Phasenumkehr -
stufe, ein als Schaltermischer arbeitender
Analogschalter und ein NF-Verstärker, an 
dessen Ausgang schließlich das I- und das
Q-Signal in der NF-Lage zur Verfügung
stehen. Die beiden Signale werden vom
USB-Soundkarten-IC digitalisiert. 
Als Lokaloszillator arbeitet ein IC vom
Typ Si570, dessen Ausgangssignal durch
ein CPLD (engl. complex programmable
logic device) in vier um je 90° phasenver-
schobene Taktsignale heruntergeteilt wird.
Diese wiederum treiben den Schaltermi-
scher. Ein leistungsfähiger ARM-Prozes-
sor steuert den Empfänger und sorgt für
die Kommunikation mit dem angeschlos-
senen PC. Auf diesem erfolgt die Demo-
dulation des empfangenen Signals mittels
entsprechender SDR-Software.

Der Antennenanschluss des Empfängers
ist als BNC-Buchse ausgeführt. Die Strom-
versorgung erfolgt über den USB-An-

schluss. Aus Platzgründen wurde eine
fünfpolige Mini-USB-Buchse eingebaut.
Passende USB-Anschlusskabel sind han-
delsüblich.
Die 3,5-mm-Stereo-Klinkenbuchse dient
zum optionalen Anschluss einer externen
Soundkarte zu experimentellen Zwecken.
An dieser Buchse stehen die I/Q-Signale
in der NF-Lage zur Weiterverarbeitung
durch eine hochwertige, stereofähige
Soundkarte zur Verfügung.
Der Kurzhubtaster hat im normalen Be-
trieb keine Funktion. Er wird nur benötigt,
wenn neue Firmware in den FiFi-SDR-
Empfänger geladen werden soll. Wenn
SW1 beim Einschalten des Empfängers
gedrückt wird, verwandelt sich der FiFi-
SDR-Empfänger aus Sicht des PC in einen
USB-Massenspeicher.
Dieser erscheint als neues Laufwerk im

Windows-Explorer. Die im Normalbetrieb
blinkende LED leuchtet in diesem Fall
nicht.
Die Detailschaltungen befinden sich im
Anhang zu dieser Baumappe.

� Aufbau
Die Platine des FiFi-SDR-Empfängers ist
bereits weitestgehend vorbestückt. Es sind
nur noch die BNC-Buchse, die 3,5-mm-
Klinkenbuchse, die Stiftleiste X3/X6 und
der Sockel für den Eingangsübertrager
einzulöten (im Bestückungsplan rot mar-
kiert). Dabei ist unbedingt zu vermeiden,
dass auf der zum Teil eng bestückten Pla-
tine unbeabsichtigte Zinnbrücken entste-
hen oder SMD-Bau elemente beschädigt
werden. Beim Einsetzen des Übertragers
TR1 ist auf die korrekte Position zu ach-
ten. 
Die Preselektorplatine wird fast vollstän-
dig bestückt geliefert, hier ist nur noch 
die Buchsenleiste aufzulöten (Bild 4).
Beim anschließenden Zusammenstecken
der beiden fertig bestückten Platinen ist ei-
ne Besonderheit zu beachten: Die Emp-
fängerplatine besitzt eine 14-polige Stift-
leiste, die Preselektorplatine jedoch nur ei-
ne 12-polige Buchsenleiste. Zwei Stifte
bleiben somit frei. Sie sind für spätere Er-
weiterungen vorgesehen und zunächst
noch ohne Funktion. Die Platinen sind so 
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Tabelle 2: Stückliste FiFi-SDR-Empfängerbausatz

Bezeichnung Wert Bemerkung
TR1 T-622-X65
(TR1) Sockel, 6-polig für TR1
X2 BNC-Buchse mit Zahnscheibe und Mutter
X4 3,5-mm-Klinkenbuchse
X3/X6 2 ¥ 7-polige Stiftleiste FiFi-SDR-Platine
SV1 2 ¥ 6-polige Buchsenleiste Preselektor-Platine
Pl1 Platine FiFi-SDR vorbestückt
Pl2 Platine Preselektor vorbestückt
Geh Gehäuse bearbeitet, 4 Befestigungsschrauben, Aufkleber
CD zum Bausatz Baumappe und Software

Bild 4: Position der Buchsenleiste auf der
Unterseite der Preselektorplatine

Bild 5: 
Vollständig bestückte

Empfängerplatine
des FiFi-SDR
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Bild 3: Bestückungsplan (Oberseite) der FiFi-SDR-Empfängerplatine, nur die rot markierten
Bauteile müssen noch bestückt werden
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zusammenzustecken, dass beide an-
schließend ohne seitlichen Versatz über-
einander liegen und sich auf diese Weise
leicht in die entsprechenden Führungsnu-
ten der beiden zuvor zusammengefügten
Gehäusehalbschalen einschieben lassen.
In Bild 8 sind die beiden korrekt zu-
sammengesteckten Platinen zu sehen, in

Bild 9 wurde die Preselektorplatine falsch
auf die Empfängerplatine gesteckt. 
Zum Schluss werden die zwei Deckelplat-
ten mit den beiliegenden Senkschrauben
an den Stirnseiten angeschraubt. Im Bild 5
sehen wir die FiFi-SDR-Platine und im
Bild 6 den fertig montierten Bausatz, je-
doch mit abgezogener oberer Gehäuse-
halbschale.

� Anschluss an den PC
Die nachstehenden Erläuterungen bezie-
hen sich auf die Nutzung des Empfängers
unter Windows-Software ab XP. 

Im Auslieferungszustand ist der Bausatz
bereits mit einer lauffähigen Firmwarever-
sion programmiert. Wer an dieser Stelle
experimentieren oder später eine neue
Version laden möchte, geht dazu gemäß
Anleitung auf der FiFi-SDR-Projektseite
vor [3]. Dort werden auch die entspre-
chenden Dateien zu finden sein. Für den
Anschluss an den PC oder Laptop ist le-
diglich ein Kabel erforderlich, das den Mi-
ni-USB-Anschluss des Empfängers mit ei-
ner USB-Buchse des Rechners verbindet.
Als provisorische Empfangsantenne genü-
gen unter Umständen schon einige Meter
Draht. Besser ist freilich eine „richtige“
Antenne, die an die BNC-Buchse des 

FiFi-SDR angeschlossen wird. Das demo-
dulierte Empfangssignal kann über PC-
Lautsprecher oder Kopfhörer abgehört
werden. Letzterer ist mit dem entspre-
chenden Ausgang der PC-Soundkarte und
nicht mit dem FiFi-SDR-Empfänger zu
verbinden (Bild 7).
Auf der mitgelieferten CD befinden sich
im Verzeichnis FiFi-Treiber die zusätzlich
benötigten Treiberdateien. Wenn der Emp-
fänger zum ersten Mal mit dem PC verbun-
den wird, sollte Windows ein neues USB-
Gerät erkennen und nach dem Treiber ver-
langen. Dann ist dieser Pfad anzugeben.
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Bild 7: Anschluss des FiFi-SDR an den PC 

Tabelle 3: Übersicht über SDR–Programme und ihre Eignung für FiFi–SDR

Name FiFi–SDR Windows Linux Mac Open Source AM SSB FM DRM
Bonito RadioJet (www.bonito.net/manuals/radiojet/ ¥ ¥ – – ¥ ¥ ¥ ¥ ¥

sites/en_Overview.htm)
PowerSDR SR40 (powersdr-sr40.sourceforge.net/) ¥ ¥ – – ¥ ¥ ¥ ¥ –
WinRad (www.winrad.org) ¥ ¥ – – ¥ ¥ ¥ ¥ –
WinRadHD (www.hdsdr.de) ¥ ¥ – – – ¥ ¥ ¥ –
Quisk (pypi.python.org/pypi/quisk/) ¥ – ¥ – ¥ ¥ ¥ ¥ –
Dream (sourceforge.net/apps/mediawiki/drm/) ¥ ¥ • ¥ ¥ ¥ – • ¥

DttSP (dttsp.org) • • • – • • • • –
SoDiRa (www.dsp4swls.de/sodira/sodira.html) ¥ ¥ – – – ¥ ¥ ¥ ¥

SRadio (www.sdradio.eu/sdradio/) • • – – – • • • •
KGKSDR (www.m0kgk.co.uk/sdr/) • • – – – • • • –
Rocky (auf der beiliegenden CD) ¥ ¥ – – – • • • –
DSPRadio (homepage.mac.com/smrozek/Sebastian_ ¥ – – ¥ – ¥ ¥ (PM) –

Mrozek/Download.html)
SDR–Radio (sdr–radio.com/) ¥ ¥ – – – • ¥ • ?
BeaconSee (www.coaa.co.uk/beaconsee.htm) ¥ ¥ – – – • • • 
Faros (www.dxatlas.com/Faros/) ¥ ¥ – – – • • • 
SDRSharp (sdrsharp.com) ¥ ¥ – – – ¥ ¥ ¥ –
LabView SDR (www.dg5mk.de/pages/ • • – – – • • – –

artikel/sdr-mit-labview.php)
Legende: – keine Unterstützung; • Unterstützung vorhanden (laut Entwickler); ¥ Unterstützung getestet
Anmerkung: Unterstützung der 192-kHz-Samplingrate noch nicht bei allen Programmen getestet

Bild 6: 
Fertig montierter
Bausatz mit abge-
nommener Deckel-
platte; die beiden
Platinen sind zu-
sammengesteckt,
oben befindet sich
die Preselektor -
platine.

Bild 9: Bei falsch zusammengesteckten Pla-
tinen sind die Längsseiten gegeneinander
versetzt.

Bild 8: Richtig zusammengefügte Platinen
liegen exakt übereinander und lassen sich
problemlos ins Gehäuse schieben.



Nach erfolgreicher Installation kann der
Empfänger sofort genutzt werden.

� SDR-Software
Im Internet ist inzwischen eine Vielzahl
von SDR-Softwarelösungen zu finden, die
es wert sind, getestet zu werden. Man wird
auf diesem Wege sicher diejenige finden,
die den persönlichen Anforderungen am
besten entspricht. Tabelle 3 gibt einen
Überblick, erhebt aber keinen Anspruch
auf Vollständigkeit. Sie stammt von der
Internetseite des FiFi-SDR-Projekts.
Selbstverständlich sind der Experimen-
tierfreude des Anwenders hier keine Gren-

zen gesetzt, da man kaum etwas „kaputt-
machen“ kann. Zum praktischen Einsatz
dieser Programme gibt es auf den FiFi-
SDR-Projektseiten Hinweise, die auf Be-
sonderheiten oder Einschränkungen ver-
weisen. Solche Einschränkungen können
z. B. auch die Unterstützung der 192-kHz-
Samplingrate betreffen.

� Rocky 3.6 
Die SDR-Software Rocky 3.6 besitzt den
entscheidenden Vorzug der einfachen In-
stallation und Konfiguration. Sie ist damit
das ideale Einsteigerprogramm für die er-
sten Schritte mit dem aufgebauten SDR-
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Bild 10: Die Programmoberfläche von Rocky 3.6

Bild 11: Auswahl der Soundkarten und eini-
ger Audio-Parameter 

Bild 12: Einstellungen im Menüpunkt DSP 

Bild 13: Die Vorschlagswerte für die Benut-
zeroberfläche übernehmen wir unverändert

Bild 14: Anzeige der auswählbaren Werte für
die Mittenfrequenz
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Empfänger. Die vorliegende Version läuft
sowohl unter Windows XP als auch unter
Windows 7. Allerdings wird eine 192-kHz-
Samplingrate von Rocky derzeit noch nicht
unterstützt. 
Inzwischen gibt es auch die an Windows 7
angepasste Version Rocky 3.7. Sie ist
ebenfalls auf der CD zu Bausatz zu fin-
den. Die im Folgenden beschriebene Ins -
tallation und Konfiguration gilt für beide
Versionen.

Installation und Konfiguration
Nach dem doppelten Anklicken der Datei
RockySetup.exe öffnet sich das Fenster
Rocky Setup Wizard. Wir klicken auf Next
und wählen einen Installationspfad oder
bestätigen den diesbezüglichen Vorschlag.
Die Option Create a Desktop Icon versehen
wir anschließend mit einem Haken und
klicken dann wieder auf Next. Mit dem ab-
schließenden Klick auf Finish beenden
wir die Installation von Rocky 3.6.
Die Konfiguration nimmt im Gegensatz zur
Installation etwas mehr Zeit in Anspruch.
Zunächst starten wir Rocky 3.6 und stellen
das Bildschirmbild auf die gewünschte
Größe ein (Bild 10). Anschließend wählen
wir im Menü View → Settings → Audio
(Bild 11).
Mit I/Q Input Device ist der Eingang ge-
meint, der für die NF-Signale vom Emp-
fängerausgang zuständig ist. Hier wählen
wir USB-Audiogerät. Dabei handelt es
sich um die vom PC erkannte Soundkarte
im FiFi-SDR-Empfänger.
Als Samplingrate stellen wir zunächst
48 kHz ein, unter channels lautet die rich-
tige Belegung Left/Right = I/Q. Die FiFi-
Soundkarte lässt auch eine Samplingrate
von 96 kHz zu. Der Empfangsbereich ober-
und unterhalb der Mittenfrequenz des Di-

rektmischers verdoppelt sich damit. Aller-
dings steigt damit auch der Anspruch an
die Rechenleistung des PC. Eine Samp -
lingrate von 192 kHz lässt sich leider nicht
einstellen. 
Audio Output Device ist die Soundkarte,
welche die Signale für uns hörbar macht
(NF-Ausgang des PC). Angezeigt wird im
Beispiel die interne Soundkarte mit den
erkannten Parametern.
Soll die hörbare NF von einer externen
Soundkarte ausgegeben werden, so müs-
sen wir diese über USB an den PC an-
schließen und dann unter Audio Output
Device einstellen. Ist alles ausgewählt, kli-
cken wir auf OK und anschließend auf
View → Settings → DSP. Anschließend
übernehmen wir die aus Bild 12 ersicht-
lichen Einstellungen. Diese sind für die
Anfangskonfiguration gut geeignet und
können später beim Experimentieren ver-
ändert werden. Es folgt der abschließende
Klick auf OK. Die beiden Haken bei View
→ Settings → GUI betreffen Anzeige-
funktionen und bleiben gesetzt (Bild 13).

Frequenzeinstellung
Rechts oben in der Bedienoberfläche von
Rocky 3.6 sehen wir die aktuell eingestell-
te Frequenz in grüner Farbe, rechts dane-
ben steht + 0.00. Letzteres ist der Offset-
betrag beim Splitbetrieb. Wenn man auf
das daneben befindliche Dreieck klickt,
klappt ein Fenster mit einer Liste der aus-
wählbaren Mittenfrequenzen auf (Bild 14).
Diese kann bearbeitet werden, d. h. es ist
möglich, Frequenzwerte zu löschen oder
hinzuzufügen.
Dazu sind die nachstehend beschriebenen
Arbeitsschritte erforderlich. 
Beispiel: Wir wollen die Frequenz 14,200
MHz hinzufügen. Dazu beenden wir zu-
nächst das Programm über File → Start
Radio → Exit. 
Normalerweise liegt Rocky auf unserer
Festplatte im Ordner Programme/Afree-
net/ Rocky. Diesen Ordner suchen wir, um
darin die Datei Rocky.ini mit den Konfi-
gurationseinstellungen des Programms zu
finden. Mit einem Editor wie dem Win-
dows-eigenen Notepad (Start → Pro-
gramme → Zubehör) öffnen wir diese Da-
tei (Bild 15). Unter dem Eintrag [Bands]
finden wir die Frequenzwerte. Wir behal-
ten die vorgegebene Syntax bei und tragen
unterhalb von 14.060_MHz=14060000
(Eingabe in Hertz) unsere neue Frequenz
ein. Dazu setzen wir den Cursor hinter die
letzte Null des vorangegangenen Ein trags
und betätigen die Enter-Taste. Nun ist Platz
für die Eingabe: 14.200_MHz=14200000. 
Anschließend speichern wir die Konfigu-
rationsdatei und starten Rocky 3.6. Die
Frequenz-Auswahlliste enthält nun unse-
ren soeben getätigten Eintrag (Bild 16).

Empfang
Zum Start der Empfangsfunktion von 
Rocky 3.6 klicken wir im Menüpunkt File
auf Start Radio. Ein Klick auf das entspre-
chende Symbol links oben in der Symbol-
leiste erfüllt den gleichen Zweck. Wenn
man mit dem Mauszeiger über die Sym-
bole fährt, gibt die dann eingeblendete
Quick-Info Auskunft über die Funktion
der betreffenden Taste. Bei angeschlosse-
nem FiFi-SDR-Empfänger nebst Antenne
müssten nun schon einige Signale zu hö-
ren sein.
Wir stellen dazu die gewünschte Betriebs-
art mittels der Taste Mode und dem ange-
schlossenen Auswahlfenster und die Sig-
nalverstärkung mit dem Verstärkungsreg-
ler ein. Die Wirkung der links daneben be-
findlichen AGC-Taste kann bei dieser
Gelegenheit gleich getestet werden. 
Die Abstimmung geschieht dadurch, dass
man entweder mittels Mauszeiger und
festgehaltener linker Maustaste den grü-
nen Anzeigebereich des Fensters ver-
schiebt oder die Scrolltaste der Maus betä-
tigt. Die Abstimmschrittweite ist dann mit
den Tasten Bild nach oben bzw. Bild nach
unten veränderbar. 
Der Schieber für das Verbreitern und Ver-
ringern des Anzeigebereiches (Zoom) be-
findet sich in der Menüleiste links neben
der Pegelanzeige (S-Meter). Mittels
Maustaste ist der Wert zwischen einfach
und achtfach einstellbar. Damit ist auch ei-
ne sehr feinfühlige Frequenzeinstellung
im Anzeigefenster gut möglich.
Über das Frequenzauswahlfenster rechts
oben können wir andere Mittenfrequenzen
aufrufen und auf diese Weise den Emp-
fangsbereich schnell verändern.

Bild 15: Auszug aus der Konfigurationsdatei
von Rocky 3.6 

Bild 16: Neue Auswahlliste mit dem hinzuge-
fügten Wert
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Versionsgeschichte zur Baumappe 
Die aktuelle Fassung dieser Baumappe
wird jeweils im Online-Shop des FUNK -
AMATEUR als ergänzende Information
zum Produkt FiFi-SDR, BX-222.0, zum
Her unter laden bereitgestellt.
Damit Leser, die die vorigen Textversionen
bereits kennen, nicht alles neu lesen müs-

sen, führen wir an dieser Stelle auf, was
sich von Version zu Version geändert hat.

Version 131115
– Ursprungsversion

Es empfiehlt sich, nach den ersten erfol-
greichen Gehversuchen mit Rocky etwas
zu experimentieren, verschiedene Einstel-
lungen und Bedienelemente zu testen und
das Abstimmen zu üben. Auf diese Weise
bekommt man die erforderliche Sicherheit
im Umgang mit dem Programm. Die
Handbuchübersetzung [5] ist dabei eine
gute Hilfe.
Zum Beenden klicken wir nochmals auf
Start Radio, das Programm kann mit File
→ Exit geschlossen werden.

� Bonito RadioJet für FiFi-SDR 
Eine von Bonito speziell an den FiFi-
SDR-Bausatz angepasste Version der leis-

tungsfähigen RadioJet-Software [6] befin-
det sich ebenfalls auf der CD zum Bau-
satz. Die entsprechenden Dateien müssen
nur auf die Festplatte des PC oder Laptop
kopiert werden. 
Unter der Voraussetzung, dass der FiFi-
SDR-Treiber bereits installiert wurde,
kann man die RadioJet-Software bei an-
geschlossenem, betriebsbereitem Empfän-
ger sofort starten. Es ist sicher auch nicht
verkehrt, von Zeit zu Zeit auf [6] nach ei-
nem Update Ausschau zu halten. 

Viel Spaß und Erfolg beim Empfang und
beim Experimentieren mit dem FiFi-SDR!
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R38, R42, R44, R45 in Festspannungsversion
der LDOs IC1 und IC9 unbestückt
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Bild A3: 
Schaltplan des HF-Teils des FiFi-SDR;
die mit n.b. gekennzeichneten Bauteile
im Bereich des Tiefpassfilters sind in der
Version mit Preselektor nicht bestückt.

Bild A4: 
Schaltplan von Lokaloszillator, CPLD,
Schaltermischer und NF-Verstärker
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Tiefpass-Filterbestückung des Preselektors zum FiFi-SDR

30 MHz 12 MHz 4,8 MHz 1,92 MHz 768 kHz 307 kHz 123 kHz
C77 NB C92 NB C9 330 C25 680 C87 680 C89 NB C114 2,2 n
C45 NB C17 100 C12 NB C28 100 C1 1,5 n C57 5,6 n C95 10 n
C54 68 C21 180 C13 470 C84 NB C4 1,5 n C64 5,6 n C108 10 n
C48 10 C20 15 C33 22 C29 1,2 n C5 1,2 n C60 2,2 n C105 10 n
C78 NB C37 150 C34 470 C41 1n C88 NB C90 NB C115 6,8 n
C52 68 C23 18 C15 56 C31 NB C7 2,7 n C62 6,8 n C106 10 n
C53 NB C24 68 C16 270 C32 680 C8 1,5 n C63 5,6 n C107 10 n
C79 NB C38 NB C35 NB C42 100 C94 560 C91 NB C116 NB
C74 NB C18 NB C82 NB C44 NB C86 NB C67 NB C113 NB
C75 2,2 C19 NB C83 47 C27 470 C3 1,2 n C65 560 C104 6,8 n
C76 NB C39 NB C14 NB C43 NB C6 820 C66 220 C112 NB
C46 4,7 C80 27 C10 47 C26 100 C2 270 C58 270 C103 1,8 n
C47 33 C81 100 C11 150 C85 47 C55 47 C59 3,3 n C109 2,2 n
C51 22 C22 56 C36 150 C30 330 C56 100 C61 2,2 n C110 5,6 n
C101 220 C100 560 C99 1,2 n C98 4,7 n C97 10 n C86 100 n C117 100 n
L15 820 n L7 1,8 µ L4 4,7 µ L10 12 µ L1 33 µ L18 82 µ L21 180 µ
L16 470 n L8 1,2 µ L5 3,3 µ L11 8,2 µ L2 22 µ L19 47 µ L22 120 µ
L17 560 n L9 1,5 µ L6 3,3 µ L12 10 µ L3 22 µ L20 56 µ L23 150 µ

Erläuterung: Mit NB bezeichnete Bauteile sind nicht bestückt. Die Bauelemente einer Zeile stehen jeweils an gleicher Stelle in der Filter-Grundschaltung 
(Bild A5). Beispiel: C21 (180 pF) im 12-MHz-TP entspricht C54 (68 pF) im 30-MHz-TP usw.

Anordnung der Filter auf der Platine (neben der Buchsenleist v. l. n. r.): HP30, TP123, TP30, TP12, TP4,8, TP 1,92, TP768, TP307


